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1. ЗАДАНИЕ 

Согласно варианту разработать систему автоматизации, привести: 

• функциональную схему автоматизации (ФСА) в AutoCAD по ГОСТ 21.408-

93, 21.404-85 (1 лист формата А3); 

• заказную спецификацию к ФСА по ГОСТ 21.110-95 (1 лист формата А3); 

• пояснительную записку (структура системы, обоснование принятых 

технических решений). 

В задании приводится упрощенная ФСА. Необходимо привести 

развернутую схему, подобрать средства автоматизации с учетом указанных 

технологических параметров, привести краткое описание выбранных приборов 

(расшифровку характеристик, задаваемых строкой заказа). 

Стиль выполнения ФСА: с выносом средств автоматизации в таблицу 

внизу схемы («подвал») или черчении их на поле чертежа (как в ANSI S5.1) на 

выбор обучающегося. 

2. РАЗРАБОТКА РАЗВЕРНУТОЙ ФСА И СПЕЦИФИКАЦИИ 

Рассмотрим решение задачи на примере.  

Пример. Необходимо модернизировать систему автоматизации насоса, 

построенную на средствах локальной автоматики щитового исполнения: 

добавить контур измерения давления, схема и исходные данные см. рисунок  1.  
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перекачиваемая жидкость – нефть,  
температура среды – 80 °С,  
номинальное (рабочее) давление – 2,4±0,1МПа, 
минимально допустимое давление Рmin=2,3кПа, 
максимальное давление перегрузки Pmax=5 МПа, 
расположение — открытая насосная, 
класс взрывоопасной зоны: 1, 
категория и группа взрывоопасных смесей: IIВ Т3. 

Рисунок 1 — Схема и исходные данные 

Решение. 

1. Выбор архитектуры системы 

Так как поставлена задача модернизации только части системы 
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автоматизации, при этом уже используются средства локальной автоматики, то 

внедряемый контур построим на подобных средствах. Вариант развернутой 

ФСА приведен на рисунке 2. Подберем технические средства: первичный 

преобразователь давления (датчик) для поз. PT 2а и вторичный прибор с 

функциями регистрации и сигнализации для поз. PIRA 2б. 
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Рисунок 2 — Развернутая ФСА 

2. Выбор датчика давления. 

Для определения пределов измерения используется принцип 2/3 шкалы. 

Рабочее значение измеряемой величины должно оказаться приблизительно на 

отметке 2/3 от всей шкалы. Тогда верхний предел измерений  

Рв=3/2∙Pраб=3/2∙2,4=3,6 МПа = 3600 кПа. 

По каталогу Метран (файл «Датчики-давления-каталог.pdf», стр. 95) 

выбираем датчик избыточного давления Метран-150. Видно, что 

предварительно по характеристикам он подходит: по измеряемой среде, по 

диапазону, по температурам окружающей среды, по взрывозащите. Уточним 

модель. Предлагаются датчики двух разных исполнений, различающиеся 

принципом измерения, который оказывает влияние на стоимость датчика и его 

метрологические характеристики. Выберем модель с емкостной ячейкой, по 

таблице 1, стр. 97, подходит 150 CG, код диапазона 5. Верхний предел выберем 

из ряда значений по ГОСТ 22520 (см. примечание 1) кратным 1; 1,6; 2,5; 4; 6 

(6,3), округлив в большую сторону 3,6 МПа:  

Pв
*= 4 МПа . 
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Оценим требуемую относительную погрешность измерения для заданной 

абсолютной погрешности ΔР=±0.1МПа: 

%5,2%100
4
1,0%100* =⋅=

∆
=

вP
Pδ . 

Выберем предел максимальной приведенной допускаемой погрешности γ 

(класса точности) выбранного преобразователя по табл. 3. Она не должна 

превышать 2.5% и должна иметь определенный «запас» по точности.  

Для выбранного верхнего предела измерения Рв=4 МПа и максимально-го 

верхнего предела Рмах=10 МПа для модели 150CG (четвертый столбец табл.1) 

проверяем выполнение условия (табл. 3): 

Рмах ≥ Рв ≥ Рмах /10. 

Подставляя значения Рв и Рмах убеждаемся, что условие выполняется 

10 ≥ 4 ≥ 1 (МПа). 

Таким образом, можно выбрать обычное исполнение γ=0,075% или PA – 

γ=0,2%. Выбираем преобразователь с кодом PA, что соответствует γ =0.2% и 

существенно меньше δ=2.5%. 

Температуры рабочей среды на входе в датчик допускается в диапазоне  

-40...149°С, что включает исходные 80 °С. 

Климатическое исполнение датчика – диапазон температур от -40 до 85 

 °С подходит для умеренного пояса для открытой насосной, где зимой могут 

быть отрицательные температуры. 

На стр. 103 каталога приведен пример условного обозначения при заказе, 

в котором закодированы характеристики, необходимые при заказе. Строка 

заполняется по таблице 6 каталога. Запишем ее, для данного примера: 

Метран-150CG 5 (0-4 МПа) 2 2 1 1 L3 A HR5 EM5 PA. 

При этом были выбраны материалы, контактирующие с рабочей средой, и 

материал мембраны (2 2) – нержавеющая сталь, что подходит для данного 

примера, потому что нефть не является коррозионноактивной для этого 

материала. 

Материал уплотнительных колец (1) – резина, это единственная опция для 
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выбранной модели CG. 

Заполняющая жидкость (1) – силиконовое масло. Второй вариант – 

инертный наполнитель применяется только для кислородного исполнения 

датчика (не нужно в данном случае). 

Выходной сигнал (A) – 4-20  мА c HART-протоколом, позволит 

использовать двухпроводную схему подключения, при необходимости 

перенастроить датчик, и опция стандартна – то есть с минимальным временем 

поставки. Версию протокола возьмем по умолчанию (HR5). 

Из дополнительных опций укажем только те по которым есть исходные 

данные в задаче. 

Взрывозащита (EM) - Сертификация взрывобезопасности 1ЕхdIIСТ6, 

1ЕхdIIСТ5: 

1 - взрывобезопасное электрооборудование, может применяться в зонах 

класса 1 и 2 (по задаче 1), 

d – вид взрывозащиты «взрывонепроницаемая оболочка» (не требует 

установки барьера искрозащиты) 

IIC – категория смеси, на которую рассчитан прибор, нужно IIB , но IIC 

подходит для смесей IIA, IIB, IIC, 

T6 – температурная группа (аналогично предыдущего T6 перекрывает 

требования T3). 

Рассчитанная ранее точность 0,2% требует опции PA. 

Внесены в Госреестр средств измерений под №32854-13, ТУ 4212-022-

51453097-2006. 

Иногда производитель предлагает заполнить опросный лист, а не строку 

заказа, пример см. стр. 118 каталога. 

Замечание.  

Если не получается подобрать прибор по температуре измеряемой среды 

(слишком высокая), то для снижения температуры в рабочей полости датчика 

рекомендуется использовать специальные устройства (удлиненные импульсные 

линии, разделительные сосуды и т.д.). При измерении не давления, а 
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температуры или уровня, возможно, поможет смена метода измерения.  

Если прибор не подходит по климатическому исполнению, то его можно 

поместить в обогреваемый шкаф (или термочехол), располагаемый вне 

помещения прямо рядом с нужным технологическим аппаратом. 

3. Выбор вторичного прибора. 

Вторичные приборы, в зависимости от назначения могут называться 

регистраторами. Вторичный прибор должен воспринимать выходной сигнал 

датчика, в нашем случае токовый сигнал 4–20 mA. Вторичный прибор одной 

модели можно использовать для индикации, регистрации, сигнализации 

различных параметров: давления, температуры, уровня, расхода и т.д. Главное, 

чтобы он соответствовал выходному сигналу датчика и функциональным 

требованиям. Например, по условиям этой задачи, прибор должен показывать, 

регистрировать и сигнализировать. 

Современные вторичные приборы обычно имеют, так называемый, 

универсальный вход и позволяют принимать как унифицированные токовые 

сигналы (0–5mA, 0–20mA, 4–20mA), так и сигналы напряжения, термометров 

сопротивления, термопар. 

Замечание.  

У некоторых вторичных приборов и других преобразователей, например, 

фирмы Yokogawa в перечне входов могут отсутствовать токовые входные 

сигналы, но имеются сигналы напряжения. (0-2В, 1-5В и т. д.). Тем не менее, 

они могут воспринимать и токовые сигналы. Для этого токовый сигнал 

пропускается через специальный нормирующий резистор (он входит в комплект 

поставки или заказывается отдельно), а падение напряжения на этом 

резисторе измеряется вторичным прибором. Пусть выход датчика 

(преобразователя) – ток 4–20mA, а сопротивлениие резистора 250Ом. Тогда при 

токе 4 mA имеем падение напряжения 1В, а при токе 20mA падение напряжение 

5В, т. е. можно использовать вторичный прибор со входным сигналом 1-5 В. 

Необходимо учитывать и погрешность измерения (класс точности) 

вторичного прибора. Следует помнить, что погрешности цепочки 
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преобразователей суммируются, и суммарная погрешность не должна 

превышать допустимой. 

Для реализации функций сигнализации вторичный прибор должен иметь 

дискретные выходные сигналы (релейный, «сухой контакт», общий коллектор 

(ОК)) к которым можно подключить сигнальную лампочку и/или устройство 

звуковой сигнализации. Аналогично можно реализовать функции ПАЗ. 

Для данного примера выберем безбумажный регистратор «Экограф-Т» по 

каталогу «Теплоприбор» (файл «00011_281-356_регистраторы.pdf»), стр. 286 

(6). У этого прибора универсальные входы, куда можно подключить сигнал от 

датчика 4-20мА. Прибор выполняет регистрацию параметров в память. 

Сигнализацию можно реализовать, используя выходные реле прибора и 

настраиваемые уставки. 

Шкала прибора должна совпадать со шкалой датчика: 0..4 МПа, для 

данного прибора это выполняется – он поддерживает задание любых 

диапазонов измерения с точностью до 5 цифр (стр. 287 (7)). При этом точность 

будет  γ =0,1% (сумма, вместе с датчиком, не вышла за ограничение δ=2,5%). 

Так как прибор будет стоять в операторной, то по климатическому исполнению: 

температура 0…+50 °С, он подходит. Взрывозащита не нужна – операторная 

является взрывобезопасной зоной.  

Карта заказа приведена на стр. 291 (11) каталога, заполним ее, выбрав 

трехканальный прибор с внешней памятью: 

Экограф-Т А 2 A 3 K D A 1. 

 По выбранным приборам нужно заполнить спецификацию, см. 

рисунок 3. Шаблон спецификации находится в файле «Primer_Specifik.doc» 
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Рисунок 3 — Спецификация на приборы 



 

3. ЧЕРЧЕНИЕ ФСА В AUTOCAD 

3.1.Настройка рабочей среды 

Настройки среды черчения вызываются пунктом меню Tools->Options. 

В диалоговом окне Options несколько вкладок, позволяющих настроить 

вид и поведения AutoCAD. Ниже приведены несколько часто используемых 

настроек. 

Изменение цвета фона. 

На вкладке Display нажмите кнопку <Colors...>. В появившемся диалогов 

окне можно настроить цвета разных элементов. Фон при 2D черчение 

настраивается пунктами 2D model space->Uniform background и в списке Color 

выбрать нужный цвет (см. рис. ниже). 

 

 
Рисунок 4 — Настройка фона 
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Изменение размера перекрестья курсора черчения. 

 

На вкладке Display настройка Crosshair size в процентрах от размера 

экрана задает размеры линий курсора. Удобная настройка — 100. 

Поведение правой кнопки мыши. 

Для ускорения работы можно настроить мышь так, чтобы быстрое 

нажатие на правую кнопку срабатывало как <Enter>, а более долгое вызывало 

контекстное меню.  

Для таких настроек на вкладке User Preferences кнопка <Right-

click Customization...> вызывает диалог  Right-click Customization, в котором 

отметьте пункт Turn on time-sensitive right-click. 

Примените эту настройку и попробуйте начертить несколько линий в 

AutoCAD. Для завершения команды — достаточно нажать правую кнопку 

мыши. После выполнения команды нажатие правой кнопки вызовет ее 

повторение. Если выделить линию и, нажав правую кнопку, немного ее 

удержать, то появится контекстное меню. 

3.2. Подключение шаблонов и работа с ними. 

Готовые шаблоны блоков технологического оборудования и приборов 

автоматизации есть в файле fsa_pi&d.dwg. Для удобства черчения их лучше 

открыть в AutoCAD Design Center. Для этого: 

1) Выберите в меню Tools->Palettes->DesignCenter 

или 

нажмите <Ctrl>+<2>. 

2) В появившемся окне найдите файл с шаблонами (fsa_pi&d.dwg) и 

откройте его блоки (blocks) как показано на рисунке ниже. 

Кнопками сверху можно настроить желаемый вид окна. Например, можно 

отключить дерево файлов кнопкой  для оптимизации места на экране. 

Кнопка  в заголовке окна сбоку позволяет включить/выключить 

автоматическое сворачивание панели  DesignCenter. 
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Чтобы вставить блок из файла шаблона дважды щелкните по нему 

мышкой. Появится диалоговое окно вставки блока. 

 

  

а б 
Рисунок 5 — AutoCAD DesignCenter. 

а) открытие файла шаблонов; б) окно после настройки 

3.3. Работа с блоками 

Для часто повторяющихся элементов чертежа, например, условных 

обозначений в AutoCAD используются блоки.  

Кнопка  (make block) – создание блока,  

кнопка  (insert block) – вставка блока. 

Блок определяется для всего чертежа, в отличии от сгруппированных 

примитивов в офисных пакетах.  

Разберем как вставить в чертеж блок, изображающий датчик. На панели 

DesignCenter найдите блок a_dat и дважды щелкните мышью на нем. Появится 

диалоговое окно вставки блока. В трех его секциях можно задать: 

точку вставки — insertion point 

масштаб — scale 
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угол поворота блока — rotation. 

Настройка Specify On-screen означает, что соответствующую настройку 

вы хотите указать на чертеже. 

Настройка Explode определяет будет ли вставлен блок как целый блок или 

разбиты на исходные примитивы (линии, круги и т.п.). Блоки из файла 

fsa_pi&d.dwg лучше использовать, не разбивая. 

 
Рисунок 6 — Вставка блока 

Выберите те же настройки, что и в диалоговом окне на рисунке и 

нажмите OK. 

Укажите точку вставки блока. 

Выбранный нами блок имеет атрибуты — функции и позицию прибора 

и теперь AutoCAD запрашивает их значения. В качестве функций укажите PT 

(датчик давления), нажмите <Enter>. Позицию укажите 100-1, нажмите <Enter>. 

На поле чертежа появилось обозначение датчика давления . 

Рассмотрим вставку блока, изображающего клапан на линию 

трубопровода, проходящую вертикально. Начертите вертикальную линию, 

которая будет изображать трубопровод.  

На панели DesignCenter найдите блок a_klapan и дважды щелкните 

мышью на нем. Появится диалоговое окно вставки блока (рисунок 4, а).  
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а б 
Рисунок 7 — Вставка блока с поворотом 

Укажите в нем, что угол поворота блока вы хотите указать на чертеже 

(галочка Specify On-screen  в разделе Rotation). Нажмите OK. Точку вставки 

укажите любую, принадлежащую отрезку трубы.  

Потом AutoCAD запросит угол поворота — укажите его так, чтобы 

клапан встал, как на рисунке 4, б. При запросе атрибутов блока согласитесь со 

значениями по-умолчанию. Направление и положение надписи позиции можно 

изменить редактирую атрибуты блока — положение и направление текста. 

Диалоговое окно атрибутов появляется, если щелкнуть дважды на блоке. Также 

атрибуты доступны из окна свойств — вызывается из контекстного меню 

(правая клавиша при выделенном блоке). 

3.4. Использование слоев 

Приложенные блоки используют три слоя, их цвета, назначение и 

рекомендуемая толщина линий приведены в таблице 1 
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Таблица 1 — Слои в блоках файла «fsa_pi&d.dwg». 

Назначение Название 

в файле 

шаблонов 

Цвет в 

файле 

шаблонов 

Линии по ГОСТ 2.303-68  

тип толщина 

Технологические 

аппараты, трубы 

tehnol желтый Сплошная 

толстая 

основная 

s 

Приборы автоматизации, 

клапана, линии связи 

KIP голубой Сплошная 

тонкая 
От  до  

 

Текстовые элементы 

чертежа 

text оранжевый   

 

Толщина сплошной основной линии s должна быть в пределах от 0,5 до 

1,4 мм в зависимости от величины и сложности изображения, а также от 

формата чертежа. На форматах  А4-А2 лучше брать 0,5-0,6 мм. Толщина линий 

одного и того же типа должна быть одинакова для всех изображений на данном 

чертеже, вычерчиваемых в одинаковом масштабе. Тип линий и толщину для 

слоя text лучше выбрать таким же, как и для слоя KIP. 

При вставке блоков из файла шаблонов соответствующие слои 

появляются сами, настроить цвет, толщину и другие их свойства можно из 

диалога Layer Properties Manager (см. рисунок ниже). Чтобы его вызвать на 

панели инструментов нажмите кнопку . В нем можно настроить следующие 

свойства  

видимость, доступность для редактирования и т.п. (см. «AutoCAD. 

Введение»); 

цвет — Сolor; 

тип линий — Linetype; 

толщину линий — Lineweight; 
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будет выводиться слой на печать или нет — Plot. 

 
Рисунок 8 — Окно Layer Properties Manager (свойства слоев). 

Смена слоя рисования и изменение некоторых из этих свойств возможна 

из списка слоев панели инструментов  Layers (рисунок 6). 

 
Рисунок 9 — Выбор текущего слоя, смена слоя объекта. 

При выделении объекта на поле чертежа на этой панели видно слой, к 

которому этот объект принадлежит. Изменяя слой в выпадающем списке этой 

панели, изменяете принадлежность объекта. Если не один из объектов не 

выделен в текущий момент, то на выбранном слое будет чертиться следующий 

созданный объект. 

3.5. Условные обозначения 

Условные обозначения технологических аппаратов и приборов 

автоматизации в шаблонах выполнены по ГОСТам разделов ЕСКД и СПДС. 

Размеры условных обозначений технологических аппаратов, за исключением 
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центробежных насосов, в стандарте не нормируются. Размеры приборов 

автоматизации и насосов нормированы, поэтому соответствующие блоки нужно 

вставлять с масштабом 1:1 в чертеж с единицами измерения мм (стоит по 

умолчанию для метрической системы).  

Размеры технологических аппаратов, за исключением центробежных 

насосов не нормируются, при черчении достаточно соблюдать соотношения в 

размерах аппаратов: большие аппараты изображаются больше, меньшие – 

меньше друг относительно друга. 

3.6. Оформление и печать 

3.6.1.Основная надпись и рамка чертежа 

Размеры форматов бумаги по ГОСТ 2.301-68 приведены в «AutoCAD. 

Введение». Рамка и основная надпись чертится по ГОСТ Р 21.1101-2013. 

Расстояние от краев листа 20 мм на переплет (слева), 5 мм — от остальных 

краев. Основную надпись можно скопировать из файла «shablons.dwg» или 

«основные надписи СПДС.dwg». 

3.6.2.Печать чертежа. 

Чтобы распечатать чертеж выберите пункт меню File->Plot. Появится 

диалог печати. Если он не развернутый (на рисунке ниже показан развернутый) 

нажмите на кнопку  в правом нижнем углу. 
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Рисунок 10 — Окно печати 
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